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1 Introduction
So you wanna start authoring songs, huh? Good for you! With a lot of passion and 
commitment, you tried to figure out how to actually do that, and...well, you might 
have hit a brick wall. The official RBN documentation is very good for people who 
know how to author and need a refresher on the rules, but not for people who are just 
getting started. Some of the tutorials out there take 20 chapters just to set up a project; 
others don’t tell you how to polish your work. This tutorial takes a different approach; 
our goal is to provide a step by step process to get you from a naked MP3 for the song 
you want to author to a fully functional CON file for your Xbox, and everything on the 
way.

The first part of this guide, the Basic Tutorial, is a step by step tutorial for the basics 
of the authoring process. It won’t put you off, it won’t require hours of reading, and it 
can be easily followed while working with the actual song you want to author. It will 
tell you what to do, but not always why. It will also skip some of the details that make 
your chart feel polished or “perfect”, especially the stuff that requires good musical 
knowledge. The idea is to provide a relatively fast route to getting your song in-game 
and playing it; you’ll have time to go back to perfect your charts once you’ve mastered 
the basics and felt the thrill of a finished song. However - and this is very important - 
there is no QUICK way to make a custom from scratch. The Basic Tutorial uses existing 
MIDI music as a base to make full-band authoring as easy as possible, but you’ll still 
need to put some effort into it. Odds are, though, that if you follow this tutorial (and 
don’t author complex songs right away!), you can get your first very rough custom 
ready to test in RB3 within an afternoon.

Every time we need to present more advanced information, we’ll refer to a Focus. 
The Focuses are appendices to this document that explain the “whys”: why the audio 
of a song starts at measure 3, why we take time signatures into account, etc. Read 
them only if you feel like more information won’t hinder you, or when you’re ready to 
discover more of the inner workings of authoring.

Finally, once we’ve given you  all the information needed to author, we will point you 
to the official Harmonix docs. They are recommended once you’ve got a handle on the 
basics and are ready to polish your songs to the quality of official Harmonix or RBN 
releases. We will also point you to the docs whenever we don’t think we can improve 
on the rules and make them simpler to understand.

To check the scope of the page you’re reading, check the “traffic light” footer. Green 
means you’re in the Basic Tutorial section, orange means you’re in a Focus, and red 
means you’re in an official Harmonix doc.
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This tutorial is for 
people who are 
unfamiliar with the 
authoring process 
and need to learn 
the whole thing. If 
you’re interested in 
perfecting your exi-
sting skills, consult 
the Focus section or 
the official Harmo-
nix docs.
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Basic Tutorial

The Basic Tutorial is a step by step tutorial for the basics of the 
authoring process. It won’t put you off, it won’t require hours 
of reading, and it can be easily followed while working with 
the actual song you want to author. It will tell you what to do, 
but not always why. It will also skip some of the details that 
make your chart feel polished or “perfect”, especially the stuff 
that requires good musical knowledge. The idea is to provide a 
relatively fast route to getting your song in-game and playing it; 
you’ll have time to go back to perfect your charts once you’ve 
mastered the basics and felt the thrill of a finished song.

C3 PowerTip

Section numbers, 
Focuses, and URL 
are all hyperlinks. 
Click on a Focus or 
section to go right 
to that page of the 
document.
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2 How You Do It
Let’s get going! How do you start and what do you need? 

2.1 How do you start?

Using an existing single instrument custom
Authoring from scratch can be a daunting task; why not start with an existing 
custom? There’s plenty of incomplete customs floating around, usually for 
Expert-only guitar. You can find them on the Frets on Fire forums and the 
community RB Customs spreadsheet, among other places. Once you’ve found 
a song you like, you can take the work that’s already been done, fix up any 
errors, and author charts for the remaining instruments from a MIDI or by ear. 

Using existing MIDI music
Authoring by ear alone is an important skill, but it can be difficult, and instru-
ments like Pro Keys can require a very good ear and a decent amount of music 
theory. With this in mind, the Basic Tutorial will assume you have a MIDI music 
file of your song to use as a base. (Just pretend you’re back in the Internet of 
1999.) Music MIDI files tend to have all instruments charted, and a well-made 
one can easily cut authoring time in half. If you’re just starting out, they’re the 
easiest way to jump in, though you should be careful not to rely on them too 
much. If a MIDI file isn’t available for the song you want to author, you’ll be 
authoring by ear the old-fashioned way (see below).

Authoring from scratch (“by ear”)
If you intend to make high-quality customs, you’ll eventually need to divine 
chart details from a fully mixed MP3. It’s really hard! The Basic Tutorial doesn’t 
cover authoring by ear. If you’d like to start out with this method, which is the 
core of professional authoring, the Harmonix docs are your best friend. Even if 
you’re importing from a MIDI and an existing chart, though, you’ll be fixing the 
chart when you notice that it doesn’t match the MP3.

No matter how you choose to get started, you’ll need to ensure that your song 
has an accurate tempo map. If your song doesn’t already have one (see the FoF 
sidebar), you’ll need to create it yourself. Take a look at the BPM, measures, 
beats, and time signatures Focus and the Tempo mapping HMX docs to learn 
more.

C3 PowerTip

Frets on Fire note: 
Using a FoF chart as 
a starting point will 
probably leave you 
with an imperfect 
tempo map. Tempo 
mapping can be 
very difficult, thou-
gh, and if you’re 
just starting out, 
even an imperfect 
tempo map is better 
than none! Once 
you’re confident 
in your authoring 
abilities, you can 
always go back and 
fix the tempo map 
later (though some 
things, like vocals, 
may need to be 
revised).

2
HOW YOU 

DO IT

3
USING 

REAPER

4
IMPORTING 

ASSETS

5
AUTHORING 

BASS

6
AUTHORING 

DRUMS

7
AUTHORING 

KEYS

8
AUTHORING 

VOCALS

9
AUTHORING 

GUITAR

10
LOWER  

DIFFICULTIES

11
OD &  

DRUM FILLS

12
ANIMATIONS

13
BEATS & 
EVENTS

14
EXPORTING 
& MAGMA

a
FOCUS

b
HMX DOCS

TUTORIAL

1
Intro

http://pksage.com/rbndocs/index.php?title=Mix_and_MIDI_Setup#Tempo_Map


5Basic Tutorial

CUSTOMS TUTORIAL FOR NEW AUTHORS

2.2 Prerequisites

Required knowledge and motivation
– You know how the game works for all instruments. If you don’t know that 
Pro Drums have toms and cymbals, that guitar has hammer-ons and pull-offs, 
etc., you first need to get acquainted with the game.
– You know the basics of how music is translated into game notes: a chord on 
guitar is represented by 2 or 3 buttons pressed at once; a green gem on G/B/K 
is a low note and an orange gem is a high note; hi-hat for drums should be 
yellow gems, etc. This is all a given for people who have played lots of Rock 
Band, but if you haven’t, you need to get more familiar with the game before 
authoring. Really minute details will be discussed in this document (dumbing 
down double bass, for example), so you don’t need to be an uber-expert, but 
you need to know how the game works.
– You want to do full band (and preferably full-difficulty) customs. You can skip 
Keys/Pro Keys for songs with complex or hard-to-decipher piano and keyboard 
parts, but there are enough single instrument customs floating around; we pre-
fer helping people who are committed to creating a song that can be enjoyed 
by the entire band.

Required software and resources
– Reaper
– RBN2 Reaper plugins
– Magma C3
– C3 Template
– (Optional) A FoF chart for guitar
– (Optional) A music MIDI (see the How to get a music MIDI Focus)

C3 PowerTip

Remember: you 
need to install the 
RBN2 Reaper plug-
ins and Magma v2 
to have full access 
to all of the develo-
per tools mentioned 
in this guide.
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3 Using Reaper

Please follow pksage’s general “Let’s Author” video
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4 Importing audio and MIDI
4.1 Importing audio and FoF chart

4.1.1 With Reaper open, find the audio and the .mid file for the custom you 
chose. Now, drag the audio in Reaper on the Tracks track. Position it so 
that the audio starts at measure 3.1.00. If you want to know more about 
why we position at 3.1.00, read the Count in focus. This is not true for 
any and all songs, but having it start at 3.1.00 is harmless enough for 
your first custom, most songs will be absolutely fine. If you want to know 
more about measure structure, read the BPM, Measures, beats and time 
signatures focus.

4.1.2 Now, import the mid file by dragging it on the free space right below the 
Tracks track. Drag it and drop it exactly at measure 3.1.00, selecting to 
expand the tracks and to merge the tempo map. 

4.1.3 Double click on the instrument track you just imported, or look at the 
preview in the main window, and check if it lines up with the audio. 
Generally the first note will be at the beginning of measure 3.1.00 but that 
means the instrument also starts, in the song, right at the beginning. If a 
song has a piano intro or some kind of sound effects, the instrument will 
then start later, and so will the chart. In our case, guitar starts right away. 
You will now see the instrument track you just imported (guitar track, from 
now on, since it’s the instrument in the example song we used).

4.1.4 If the MIDI doesn’t line up, undo the importing (two times, und import 
and undo the creation of the tempo map), and reimport it 1 or more beats 
earlier, as need. DO NOT move the MIDI track around once imported 
because it will lose sync with the tempo map, so undo importing and 
reimport. If the audio now looks not aligned, move again the audio track 
so that it starts at 3.1.00.

4.1.4 Now we do a foolproof copypaste. First of all, drag the MIDI guitar track so 
that it extends to the very beginning, at measure 1.1.00. DON’T MOVE IT! 
You need to drag the left end so it touches the beginning of the project, so 
that it looks like all the other MIDI tracks in the project. Now double click 
the track to open it. Look at the bottom of the track and you will see the 
PART GUITAR text event. Drag that to 1.1.00. Now you simply select all and 
copy.

4.1.5 Open the GUITAR track in the template, point the cursor to 1.1.00 and 
paste. Now all your notes are all in the original position. This works for any 
MIDI file you need to import and it’s a foolproof way to paste in the very 
same position.

4.1.6 You now have the guitar part done. You can delete the FoF chart track. 
Before moving on, to spare some time you may want to check if the 
ending is not too difficult to author for the other instruments because 
of how loose it is. If it is, it needs a Big Rock Ending. Read the Big Rock 
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Ending HMX docs to know more.
4.1.7 Finally, when you want to polish any FoF chart, read the Cleaning up FoF 

charts focus.

4.2 Music MIDI import
4.2.1 Now you have a project with a couple of very important pieces: a tempo 

map and an instrument part that gives you some reference. Now, let’s 
import the music MIDI for all the other instruments. We assume you 
already have the MIDI, otherwise read the How to get a music MIDI focus.

4.2.2 Take your MIDI file and drag it in Reaper at measure 3.1.00 but, and this is 
very important, DO NOT merge the tempo map. Once you have imported 
the MIDI, check that the notes start where they should using the guitar 
track as a reference, since you already have an authored guitar part. If 
not, move them accordingly (music MIDI sometimes have a count in, 
sometimes don’t, that’s why notes may or may not line up properly at 
3.1.00). In this case, you can move the MIDI around with no issues.

4.2.3 Now zoom out and look at the song: does it look like the MIDI file you just 
imported is as long as the song? If so, perfect. If not, that’s a case for a 
focus: Working with non-matching MIDI files.

 
 Now that you’re all set, let’s do the missing instruments...

C3 PowerTip

When importing 
FoF charts take a 
look at the tempo 
map: if you see 
spikes in it (i.e. a 
couple of beats with 
BPM double the 
rest of the songs, 
possibly repeated), 
chances are it’s a 
tempo map that will 
need fixing once 
you’re confident 
with authoring.
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5 Authoring Bass
5.1 The bass part is usually the easiest. Open the MIDI track and look at the 

notes. You will notice 2 things: a pattern and empty rows. Now, instrument 
parts don’t use all notes in any interval, because of music keys and all 
(something that’s out of the scope of this tutorial). So, the first thing is to 
simplify the track: select all notes to the bottom of an empty row and shift 
them up with the UP cursor arrow. Do that as many times as you need so 
that you don’t have any empty row, meaning no row with no notes in it (a 
row with a single note in a song is not empty). 

5.2 Now look at the patterns. You will notice that any song has patterns: 
phrases will most often than not use the same notes, choruses too. What’s 
important here is consistency: we need to go from a music notation to 
a 5 MIDI game note notation preserving as much as possible the feel of 
the original. That means that in game, if you play two phrases that are 
identical in the song, you need to see on the fretboard the same notes.

5.3 Recognise those patterns, start with one and select all those notes for all 
the parts in the song with the same pattern. Now, move all the notes up or 
down, it’s up to you, so that they’re isolated. 

5.4 Now you start the last process of “dumbing down”, and this time it’s easier 
because less notes are involved. Repeat the “moving up” notes process. At 
this point is just a matter of taste and feel of the song, so make sure your 
5-button pattern makes sense. Move the finished parts all the way down 
to the bottom of the MIDI track so they’re out of sight. Repeat that for any 
other pattern you find moving all finished stuff down.

5.5 Once you’ve cleared all patterns, you can move to the rest of the song to 
finish it.

5.6 What you now have, ideally, is a track with notes in the correct place and 
with the correct feel in a 5-button range. Notes length though will be off. 
Adjusting notes length is simple, though a bit time consuming. So, at the 
beginning, you can shorten them in a quick albeit rough way: select all 
notes, zoom in so that on screen you can basically see only a couple of 
measures, then from the Actions menu in the MIDI window select Shorten 
notes one pixel. Use it how many times you need to leave roughly a 1/16 
of a measure between the end of a sustain and the following note. Now, 
with all the notes still selected, from the Actions menu in the MIDI window 
select Lengthen notes one pixel. Use it 3 times so that notes you shortened 
to 0 length now have substance. To shorten notes in a more precise 
manner, you can read the Reducing notes length focus. 

5.7 You now need to clean the MIDI track. MIDI tracks have all kinds of events 
and commands that Magma not only doesn’t need but doesn’t want. With 
the MIDI track open click on View > Mode: event list. Now delete anything 
which type is not Track name or Note. That’s it, MIDI track cleaned.

5.8 Now copy all notes with the foolproof method to the PART BASS track. 
5.9 Now you have notes with the correct length and in the right places... or do 

C3 PowerTip

Bass is probably the 
most difficult instru-
ment to actuallty 
hear in some of the 
mixes. If you can’t 
find an accurate ta-
blature or MIDI file, 
try to chart what ac-
tually makese sense 
rhythmically using 
drum kicks to help: 
if you can’t make 
out the bass track, 
bass notes along 
with bass drum no-
tes generally make 
the most sense.
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you? Music MIDI file can be fairly accurate but sometimes, just sometimes, 
can be really off. Even when they’re spot on, MIDI files are not created to 
be a perfect reproduction of the original, so you will need some tweaking. 
To do that, open the MIDI track, resize it and move it to the bottom of the 
screen. Open the Bass RBN plug in, go to the beginning of the song and 
play it. Every time something seems off, just fix it in the MIDI track. Also, 
remember to add Solo makers where needed.

5.10 Once you are confident with authoring Bass using a MIDI file, read the 
Perfecting MIDI translation for chords instruments focus. Once you are 
confident authoring Bass with all subtleties, read the Perfecting Bass/
Guitar authoring focus.
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Still can’t hear 
the bass? Add the 
ReaPitch plug-in to 
your audio track, 
transpose it by an 
octave and bass will 
pop up.
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6 Authoring Drums
Music MIDI tracks for drums are different than those of other instruments. Every 
MIDI note for drums actually represents a piece of a drum kit. You will find bass 
drum, snare, hi hat, open hi hat, ride, crash, low, medium and high toms etc. Not 
all MIDI tracks for drums use the same note for every piece of kit and sometimes 
drum tracks are split into the separate piece, so you need to put the together 
with the foolproof copy/paste method. Plus, drums are possibly the least accurate 
instruments in music MIDI files, so considering all of the above, what you should 
do is use the drum MIDI track as a reference only. 

6.1 Start the music first and identify which notes represent which piece of kit. 
Then, get a general feel of how accurate the track is. If you’re lucky and 
the MIDI track is accurate enough, go through that and fix what is not 
accurate using the same note the MIDI file uses (so if a kick note is missing, 
add it in the kick notes row). If it’s not accurate, read the Authoring drums 
by ear focus. Drums are the easiest instrument to chart by ear, by the way.

6.2 Once you’ve got the track right, it’s time to convert it to a 5-lane track. 
What follows is a simple “conversion” table: what original sound/piece 
goes to which color. You will be preparing a total of 8 lanes: 5 for standard 
and 3 for pro drums. You need to move all the relevant notes to the MIDI 
note row detailed. If you already have notes on MIDI lanes 90 and above, 
select all notes, press T, use -12 as offset and transpose. If you need to 
move them down further, use multiples of 12. Now, here’s the conversion 
table:

Drum sound/piece of kit Game color MIDI note/row

Kick note Orange 96

Snare Red 97

High tom 
(high pitched sound)

Yellow 110

Medium tom Blue 111

Low or floor tom 
(low pitched sound)

Green 112

Rim shot (the edge of the 
snare sound, most of the 
times woody or metallic)

Red 97

Hi hat (the 'tsk' sound) Yellow 98

C3 PowerTip

Drums for a lot 
of songs not only 
repeat phrases but 
inside phrases have 
repeated pattern. 
Once you recognise 
the pattern, you can 
copy and paste to 
cut down times.
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Drum sound/piece of kit Game color MIDI note/row

Open hi hat 
(the more spacious hi hat 
sound usually suddenly 
stopped)

Blue 99

Ride 
(bell suond)

Blue 99

Crash 
(large, spacious cymbal 
sound)

Green 100

Cowbell Blue 111
 
 This is a simple conversion table for simple songs. For complex sounds, 

long fills, etc., read the Perfecting drum kit sounds authoring focus.
6.3 Now you have all kick, snare and cymbal notes right, but you only have pro 

markers for toms (notes 110 and above). Copy all pro markers and paste 
110 notes on note row 98, 111 on 99 and 112 on 100.

6.4 Your drums chart is now done. Clean the MIDI track and copy/paste over 
the PART DRUMS track. Remember to add Solo makers where needed.

C3 PowerTip

Rim shot and snare 
usually share the 
Red color. When 
the drummer keeps 
the beat on the Ride 
(blue) and you have 
a streak of rim shots 
and then the drum-
mer starts playing 
the snare, consider 
charting the rim 
shot to Yellow to 
better represent 
the change in the 
pattern.
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7 Authoring Pro Keys/Keys
7.1 Choosing instruments

7.1.1 When authoring keys the first thing you need to understand is what you 
actually want to chart. Let’s get one scenario out of the way: if you’re 
doing a song that has only piano as a candidate for keys (no strings, no 
synth, no brass instruments, etc.) everything gets a bit more complicated, 
because as a general rule, for piano you need to only author the right 
hand of the piano transcription. That means that inside a MIDI track you 
need to recognize which part goes to the right hand. As a very general, 
quick and dirty, rule, the right hand plays the main melody, which means 
you can delete, from the MIDI track, any note that usually is far down the 
MIDI track, because, again as a general rule, that’s what the left hand 
plays. For a more accurate piano authoring, read the Piano authoring HMX 
docs.

7.1.2 Another scenario is a song with only one non-piano instrument to be 
charted for keys (strings, saxophone, etc.). In that case you can skip ahead 
to Managing the Keyboard range.

7.1.3 The most common scenario though is probably the one in which more 
than instrument that can be charted for keys is present in the song. In 
example, you can have strings, then some synth, then a sax solo, etc. In 
that case you first need to lay out your tentative chart. Listen to the song 
and for every part where more than one candidate is present choose the 
one that’s more prominent or fun. Remember, try not to jump between 
parts: stick with one if there’s enough to author and always find a good 
spot to change instrument so that the player isn’t confused by the change.

7.1.4 Once you have found the instrument you want to keep for each part, 
delete all the notes in the those part for other tracks. Once you’ve finished, 
you end up with a single keyboard part split into the individual instrument 
tracks. Use the foolproof copy/paste method to copy all those notes to one 
single track: use the one with more notes left in it.

7.2 Managing the Keyboard range

7.2.1 What you have now is the complete track. Now you need to author pro 
keys first and then, as you did for all the other instruments, reduce it to 
a 5-lane version. Now, the game keyboard has a range of a 10th, which 
may be gibberish to you but it essentially means that you can’t cram any 
range of notes in your chart. Look at your chart and find the lowest note 
you see. Your range is from that note to the same note an octave (12 
rows) up and a couple more. So, in example, if your lowest note is a C2 (a 
C note, 2nd octave), you can use as a range for any given section, all the 

C3 PowerTip

You can only use 
notes between C2 
and C4, which is 
2 octaves. If your 
chart is actually 
between 2 octaves 
but higher or lower 
than those (betwe-
en C1 and C3, in 
example), just tran-
spose everything 
down or up 1 or 2 
octaves as needed. 
Press T for transpo-
se, insert 12, -12 or 
multiples thereof 
(12 rows down is 
an octave down, in 
example) and then 
click Transpose.
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notes between that C2 and the E3 note. This won’t probably be enough for 
almost any song you author. So, you need to optimize. First thing to know 
is the list of ranges available. Here it is:

 C2-E3
 D2-F3
 E2-G3
 F2-A3
 G2-B3
 A2-C4
7.2.2 Before going into the “any given section” business, we need to do a first 

pass at optimizing things. Look at your chart and see if any notes are an 
octave or more lower or higher than they could be. In example, xylophone 
notes tend to be very high and trombone notes very low. If they are simply 
an octave or two down or up your main melody, select those notes and 
press T for transpose. Insert 12, -12 or multiples thereof (12 rows down is 
an octave down, in example) and then click Transpose.

7.2.3 With than done, your chart may now fit in a 10th. Check the lowest 
and the highest note against the range list: if everything fits, you have 
completed the rough pro keys chart, so skip ahead to Fixing up the pro 
chart. If it doesn’t, you can still tinker a bit transposing notes. Say that you 
have a C2, D3, E4 notes sequence: you can shift the E4 note down to E3 to 
make it fit. Or sometimes, a chord can have one note right outside of your 
range: consider removing that note if the feel of the song is still preserved. 
Your objective is at least have all notes fit in the C2-E4 range. Once you 
have that, we need to see that “any given section” business. But fix, let’s 
fix up the chart…

7.3 Fixing up the pro chart

7.3.1 You pro keys chart is now prepped: it’s between C2 and C4 and it’s got 
all you want in it. Notes length though will be off. Adjusting notes length 
is simple, though a bit time consuming: all notes that are shorter than 
¼ don’t have a sustain. All notes ¼ and longer must have a sustain that 
ends when the note sound ends but always at least a 1/16 before the 
following note. To help you with this just use the Grid drop down menu at 
the bottom of any MIDI window in Reaper. You can set it to ¼ to check for 
sustains and you can set it to 1/16 to shorten notes. Shortening is simple: 
just drag the notes end tail back. If you set the grid to 1/16, just drag them 
back one “click”. To cut down shortening times, you can read the Reducing 
notes length focus. 

7.3.2 You now need to clean the MIDI track. MIDI tracks have all kinds of events 
and commands that Magma not only doesn’t need but doesn’t want. With 
the MIDI track open click on View > Mode: event list. Now delete anything 
which type is not Track name or Note. That’s it, MIDI track cleaned. Now 
copy all notes with the foolproof method to the PART REAL_KEYS_X track. 

C3 PowerTip

Sometimes piano 
can be very complex 
to author, most of 
all when it’s spora-
dic and pops out of 
the mix only rarely. 
In those instance, 
consider authoring 
another instrument 
present in those 
parts to make your 
life easier: as a 
good rule, for songs 
with hard to hear 
piano parts, find 
a part that makes 
enough sense to 
author and you can 
ignore all those 
piano parts.
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7.3.3 Now you have notes with the correct length and in the right places... or do 
you? Music MIDI file can be fairly accurate but sometimes, just sometimes, 
can be really off. Even when they’re spot on, MIDI files are not created to 
be a perfect reproduction of the original, so you will need some tweaking. 
To do that, open the MIDI track. Now enable the PART REAL_KEYS_X fx and 
play. Listen to the part and if something seems off, just fix it in the MIDI 
track. Does EVERYTHING seem off? Take a peek at the Stepping down and 
up focus. Also, remember to add Solo makers where needed.

7.3.4 If your chart doesn’t nicely fit in a single notes range, you need to use Lane 
shifts, otherwise skip down to Creating a 5 lane version. However, when 
you’re confident with your pro keys charting, you can advance your skills 
by reading the Perfecting Pro Keys/Keys authoring HMX docs.

7.4 Using lane shifts
 So, if the entire song doesn’t fit in a single range, you can use any of the 

other ranges. To do that, you need to use lane shifts: we refer you the 
official Harmonix docs. 

7.5 Creating a 5 lane version
 Reducing the pro keys to a 5 lane version work like reducing Bass or Guitar 

with only one exception: you can have overlapping sustains (but of up 
to only 3 notes at once, a limitation valid for pro keys too). Once you are 
confident authoring Keys with all subtleties, read the Perfecting Keys 
authoring HMX docs.
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8 Authoring 
Vocals & Harmonies

Please follow Nyxyxylyth’s vocals tutorial video
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9 Authoring Guitar
You can skip this paragraph if you used a FoF chart to base your custom on, 
obviously... 

So, you don’t have a guitar chart to start with AND you can’t/don’t want to author 
by ear. In that case, guitar needs some serious attention. In essence, guitar works 
like bass in terms of reduction from musical notation to 5 lane. However, guitar s 
far more complex. . 

9.1 First of all, when you import a MIDI file, in all likelihood you will see more 
than one guitar track. That’s because not only there may be more than 
one guitarist for the song but because there may be more guitar parts 
(overdubbed by the same guitarist) and because guitar solos are usually 
sequenced on a different track. 

9.2 Since you only author a single guitar part, first thing you need to do is 
select what to keep. You will of course keep the solo, if there is one: 
you can therefore delete all the notes from the other guitar parts that 
occur during the solo. Then, go through the song and listen for the more 
prominent and consistent part. Keep in mind that you don’t have to fill 
every second of the song with guitar notes: switching madly from a guitar 
part to another (in example from an acoustic rhythm part to a lead guitar 
part) and back will simply confuse the player. So, choose a part and try to 
stick it (usually the part with the most flare and the less repetitive one). 
If the prominent part is sporadic, you can switch back and forth to and 
from the rhythm part but make sure there’s some space between the parts 
and that it’s done tastefully. In example, if the electric guitar part ends at 
the 2 of the measure, rejoin the rhythm part at the beginning of the new 

measure. If you want to know more about measures, read the focus, 
otherwise just make sure you rejoin the rhythm part at the beginning of a 
pattern.

9.3 The other difference is chords. When you reduced the bass part, you only 
had to deal with single notes and, in very rare case, 2-note chords. Guitar 
however is different: you can easily find 4 and 5 note chords and acoustic 
guitar tabs will come with almost only 4/5 note chords. That poses a 
question: how do you reduce 5 notes to 3, which is the maximum number 
of notes for a guitar part? Well, you can go about that in 2 ways...
A. In some cases, songs will use almost only chords that share 1 or 2 

notes. That means that effectively if you remove in example the 2 
lower or the 2 higher notes from every chord, you will end up with 
3-note chords preserving the “movement” of the song. 

B. To preserve movement and consistency, you can go over all the 
chords for your song and assign them “manually” a 3 GRYBO note 
combination. Do all the single note parts of the song first, then with 
only the chords left to process, just choose your combination and 
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copy the notes over each matching chord in the song. Just make sure, 
again, to preserve movement (a higher musical chord must a have 
a higher 3-note combination, meaning it needs to have more YBO 
notes) and obviously to preserve timing and length of the original 
notes.

9.4 For everything else, just follow the Bass part tutorial. Once you are 
confident with authoring Guitar using a MIDI file, read the Perfecting 
MIDI translation for chords instruments focus. Once you are confident 
authoring Guitar with all subtleties, read the Perfecting Bass/Guitar 
authoring focus.
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10 Lower Difficulties
Once you have finished all your instruments, you can do Hard, Medium and Easy 
difficulties. However, a lot of errors you only catch during testing and most of 
them will reflect on all difficulties. For that reason, always finish testing for your 
Expert charts, then go back to author lower difficulties. After you have finished 
authoring Expert, so, copy and paste the Expert chart over Hard, Medium and 
Easy, because otherwise Magma will throw exceptions. Once you’ve finished 
testing, and you want to do lower difficulties for your first customs, come back 
here and follow the official Harmonix docs for reducing a chart. If you only play 
Expert you can leave this for a future time, but remember that if you want to 
release your songs you want all players to be able to play, not only Expert players.
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C3 PowerTip

CAT (C3 Automation 
Tools) provide an 
excellent starting 
point for very 
accurate reductions. 
You can launch the 
automatic reduc-
tion supersets by 
also customising its 
options, and then 
tweak what needs 
adjusting. 

http://pksage.com/rbndocs/index.php?title=Main_Page
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11 Overdrive & 
drums activation fills

Once you’ve completed all your instruments it’s time to add Overdrive for all of 
them. For that, you can read the Harmonix official docs.

Then, off to author Drum Fill Lanes with Harmonix Harmonix official docs.
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12 Animations

(By TrojanNemo)

Venue and Animations usually get lumped together, since they affect how the 
song presentation will be and what it looks like on screen. However, they are two 
separate aspects. Venue is its own MIDI track, and controls the camera cuts, the 
lighting, the post-processing events, and some of the behavior of the players and 
the crowd. Animations determine how each character will be animated or not 
on screen. Since Animations are the first thing to be noticed when they’re done 
incorrectly or not done at all, let’s start with that.

12.1 General Animation Events

Every player has the following animation events in common. These are entered 
as Text Events in that instrument’s chart, at the moment you want it to happen.

[play] – animates the player to the beat of the song, depending on what 
animations you have assigned to them (below)

[intense] – same as above, but as the name suggests, in an intense manner 
(think for Aggressive Metal, for example)

[mellow] – same as above, but in a very relaxed, mellow manner (think Slow 
Jam type of songs)

[play_solo] – not known exactly what the difference is between this and [play], 
but it is one of the accepted play states, I use this when that instrument has a 
solo in conjunction with the directed cameras (see Venue) below.

[idle] – player will bop their heads, wave their hands, etc, to the beat of the 
music, use before the song starts, after the song finishes, or if there is downtime 
for that player during the song (I typically use it if there’s at least 2 measures of 
rest)

[idle_realtime] – use when you don’t want the player to do anything to the 
beat of the music, they will just be there, waiting for their cue. This is useful for 
slower songs or slow parts within songs

Beginner’s Tip: When starting out, just get in the habit of putting [play] at 
the 2.1.0 or 3.1.0 depending on when your song starts. This will give you an 
animated player, you can experiment with other states later.
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C3 PowerTip

Most animation’s 
work can be done 
simply using CAT, 
the Python-based 
set of authoring 
tools for Reaper. 
CAT commands 
include automatic 
generation of drums 
animations, [play]/
[idle]/etc. auto-
matic positioning, 
creation of the BEAT 
track and much 
more. If you author 
in Windows, CAT is 
strongly suggested.
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12.2 Animating the Drummer
Start doing the animations as soon as you have finished the Expert chart: 
just copy down the chart (Alt + C) to use as a base. Check if you have any pro 
markers for this song. If you do, select all Pro notes, move them over their 
counterparts. Select MIDI > Action > Correct overlapping notes. DO NOT 
deselect notes. Move notes back to their original spot: now pro notes are tom, 
non pro notes are cymbals.

 Kicks
 Drag your expert orange notes to KICK RF. This is your right foot. If you have a 2x 
Bass Pedal, you’ll notice there’s no KICK LF. For those extra kicks, you can use HI-
HAT OPEN, which is the hi-hat pedal.

 Snares
 Drag your expert red notes to SNARE HARD LH. The vast majority of times, 
this will be the correct way. If you are certain they are soft snare hits, you 
can instead move them to SNARE SOFT LH. Snares are typically played in 
conjunction with another note, that’s why you want to put them on the left 
hand, freeing the right hand to play whatever else is there. If you have a roll or 
more than one of the same note, alternate hands. 

 Hi-Hats (Yellow/Blue Cymbals)
 Closed hi-hats are typically charted as yellow cymbals. Drag and drop your 
expert yellow notes to HI-HAT RH. Open hi-hats are typically charted as blue 
cymbals. Drag and drop those to HI-HAT RH & draw a note for each open hi-hat 
note on HI-HAT OPEN. If you have a string of open hi-hats, you can also just 
draw a long note on HI-HAT OPEN until you want it to close.

 Rides (Blue Cymbals)
 Drag your expert blue notes to RIDE CYM RH. Keep in mind any open hi-hats 
charted to blue cymbals you may have done previously, and delete those from 
the RIDE CYM RH line.

 Crashes (Green Cymbals)
 Drag your expert green notes to CRASH1 HARD RH. If you have experience 
drumming and can tell the difference between types of crashes, you can use 
any of the ones listed as CRASH _____.

 Toms (Yellow/Blue/Green Pads)
Move yellow toms to TOM1 RH, blue toms to TOM2 RH and green toms to 
FLOOR TOM RH.

 Alternating and correcting hand placement
 The instructions above will give you a solid starter animation structure. 
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However, you most likely have to correct a few things. As mentioned above, 
you don’t want a string of the same note being played on the same hand, as 
that is not realistic. You want to alternate hands in the animations much like 
we do in real life, usually starting with the right hand. The other thing is to 
make sure you don’t have two right hand or left hands at any given beat. If you 
have two toms or cymbals being played at the same time, you’re going to want 
to move one (usually the left-most hand on your drum kit) to be on the LH. 

 

12.3 Animating the Guitar / Bass players

The game autogenerates the right hand animations based on the chart, so you 
don’t have to. Most of you will be fine with just adding the animation events as 
described above, and your player will animate in game.

If you want to also specify the left hand movement, it requires knowledge of 
how to play a (real) guitar or bass. The game allows you to specify where the 
hand is on the neck of the guitar/bass, the handmap for the left hand, and the 
type of strums for the right hand on bass.

12.4 Animating the Singer
To have the singer move, all you need are the animation states mentioned 
at the start of this tutorial. You don’t need those animation states for the 
harmonies, only in PART VOCALS.

The game will generate the lipsync based on the lipsync file you give Magma. 
You want the following, in order of animation accuracy:
1) dry vocal track (i.e. no effects, reverb, etc.)
2) wet vocal track (i.e. the stems we get from Guitar Hero, The Beatles, most 
online multitracks)
3) your own recording (equivalent of a dry vocal track but presumably not as 
accurate)
4) rendered MIDI track (see below)

If you’re using 1, 2 or 3, import it into REAPER, align it with the chart, extend 
it so it reaches the start of the track, press the SOLO button, right click on the 
track > Render/freeze tracks > Render tracks to mono stem tracks, 16 KHz, 
16-bit, mono. If you can’t get 1 or 2, and you’re certain your own recording 
would be horrible, then you can try to cheat the game a little by rendering the 
actual MIDI chart. Make sure the MIDI playback is enabled for PART VOCALS 
if it’s a song without harmonies, or HARM1/HARM2/HARM3 depending on 
which harmony you want to render. Mute all other tracks then use the same 
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rendering process as above. This process gives you a very average lipsync that, 
however, is better than not having any lipsync.

12.5 Animating the Keyboard player

The C3 templates have two charts for keyboard animations: PART KEYS_ANIM_
RH& PART KEYS_ANIM_LH. You can fill PART KEYS_ANIM_RH track, with the 
content of PART REAL_KEYS_X. Animation states must be added to PART KEYS.

12.6 Creating the Venue

The venue controls your camera cuts, lighting and special effects. First of all, an 
autogenerated venue is best 95% of the time. Even if you’re very comfortable 
in creating the venue and know all that goes into it, there is very little to 
be gained from manually creating the venue rather than having Magma 
autogenerate one and then modifying that to match your needs. This tutorial 
therefore assumes you will autogenerate and then modify, but if you insist on 
manual creation everything said here will still apply. 
Possibly the most important part of creating a venue is not the venue itself, 
but practice sessions. Practice sessions are the named sections that you see 
when you go to Practice Song. These go in the EVENTS track. These are the 
only things that go in the EVENTS track. Magma uses them to generate your 
venue. The more accurate your practice sessions are, the more accurate the 
autogenerated venue will be. To add them, open your EVENTS track, play 
through the entire song (with all audio channels enabled) and add them in as 
you go along. You will always have the following

EVENTS – track name at the start of the track. Every other event is A TEXT EVENT 
in this track.

[crowd_normal] [crowd_mellow] [crowd_intense] – add one of these at 2.1.0 
and then as often as you think necessary. As the name suggests they change 
the crowd’s behavior.

[music_start] – add right where the crowd would recognize the song 

[music_end] – add right when the music ends, this initiates the crowd cheering 
and “end of the song” animations and effects

[end] – this ends the song and takes you to the scores screen. You can have this 
as close or as far from [music_end], but not before. There can’t be ANYTHING 
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after [end], no notes on any instrument, no tempo changes, no more beat 
notes, nothing.

After you have the above in place, you need to start adding the different 
sections of the song. What will make your venue stand out is how accurate 
you are in adding your practice sessions. The more accurately you lay out your 
intro, solo, etc. sessions, the more precise animations will be. 

Save your REAPER project, export the MIDI and open Magma (Magma project 
creation and MIDI exporting is covered just ahead in the Magma and final CON 
file section). Click on the Game Data tab, and choose your Autogeneration 
Theme. Pick the one closest to your song then click on Export. You can name 
that Venue.mid. It has all your tracks, plus the autogenerated Venue. Import 
the MIDI in reaper, copy the Venue chart and paste it into your song’s REAPER 
project. 

Your song now hase animations, good practice sessions and decent camera 
cuts. Iff you want to make it even better, read the Advanced Venue Editing 
focus.
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13 Events and Beats track
Well, you’re almost there! Now you need to tell the game two things: when the 
song ends and how to draw the fretboard grid. 

13.1 Open the Events track and move the [music_end] marker to where the 
music end. Then move the [end] marker to where you want the gamer to 
cut out to the scoring summary screen. Set your grid to ¼ before doing so. 
If you have a Big Rock Ending, read the Big Rock Ending HMX docs.

13.2 Now, for the Beat track... The template accounts for a 4/4 song properly 
structured, meaning the 1 of the first measure of the song properly starts 
at 3.1.00. If you don’t have time signature changes, you only need to 
delete all markers right up to the [end] event. So, select both Events and 
Beat tracks by control clicking both and then double click on the Beat 
track, so that you can see the Events track markers overlayed on the Beat 
track. So, delete all Beat markers up to the [end] event: in example, if the 
[end] event is at 80.3, your last Beat marker can and has to be at 80.2. One 
beat less and one beat more will both throw errors in Magma.

13.3 If you have time signature changes, make sure that there’s only one 
Downbeat marker for every measure and that that masker is at the first 
beat of every measure. 
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C3 PowerTip

CAT can take care of 
creating the BEAT 
track for you. Just 
make sure your 
[end] even is cor-
rectly positioned. 

http://pksage.com/rbndocs/index.php?title=Overdrive_and_Big_Rock_Endings
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14 Exporting 
and CON Production

14.1 Exporting 
You are now ready to export your work! You will need 4 things:

- A 44 KHz, 16-bit, stereo WAV file for the entire song
-  A 44 KHz, 16-bit, stereo mute WAV file for the entire song
- A 16 KHz, 16-bit, mono WAV file for the entire song for dry vox (if 
 you want to do proper lip sync, read the Dry vox focus)
- A MIDI file

14.1.1 Turn off all instrument plug ins. Then, shorten all MIDI tracks for that they 
are all of the same length, taking care of not shortening so much that the 
[end] event in the Events track gets cut off. Having all MIDI tracks of the 
same length allows you to render the audio at a proper length.

14.1.2 With all plug ins turned off, to avoid clicker and MIDI sounds being 
rendered out, select File > Render and use the settings you see in the 
picture. This is gonna be the main audio.

14.1.3 Now mute all audio tracks and re-render to a new file: this is gonna be the 
muted audio track (if you’re curious, read the Why do we need a muted 
track? focus).

14.1.4 Now render audio the Dry vox file: use the above settings for that.
14.1.5 Finally, File > Export project MIDI to export the MIDI: make sure to use 

the settings you see in the picture, specifically the Embed tempo map and 
Multitrack MIDI file checkboxes.

14.1.6 You are now ready to go through Magma…

14.2 Magma and final CON file
14.2.1 Open Magma. In the Information tab you need to input all the song’s data. 

Not much to know here except that you need to make sure to use a good 
quality version of the album picture.

14.2.2 In the Audio tab make sure that Drum mix is set to Kit if you’re NOT using 
multitrack audio. If you are, read the Working with multitrack audio 
HMX docs. For each instrument, use your muted file (again, if you’re 
using multitrack audio, read the focus). For the Dry Vocals parts, use your 
dry vox file. Finally, use your actual audio for the BACKING part. Set the 
BACKING volume level to 0.0 and select a preview starting point.

14.2.3 In the Game Data tab, link to your MIDI file. Select a theme for your venue, 
an animation speed, the vocal percussion style to match the one you used 
in PART VOCALS and the singer’s gender. Set your tiers for all instruments, 
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select a folder to build to and a file name, and save your Magma file.
14.2.4 You are now ready to hit Build. For common Magma errors, read the 

Common Magma Errors focus. When everything is fine, you’re ready to go 
from RBA to CON.

14.2.5 You now have an RBA file. Open rb3maker, select File > Open folder, select 
the folder the RBA file is in and… you have a CON for your song! You can 
now play the song in game and test it. 
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Focus

Every time we need to present information that is not basic, 
we’ll use a Focus. A focus is an explanation of most of the whys: 
why we have the audio of a song starting at measure 3, why 
we take time signatures into account, etc. Read that only if you 
feel like more information is not hindering you or when you’re 
ready to discover more of the inner workings of authoring.

Remember: this section is not supposed to be read sequentially 
but it’s rather to be accessed focus by focus when needed, 
directly from the basic tutorial sections.

C3 PowerTip

Each focus brings 
you back to the ori-
ginal page: just click 
on the hyperlink 
at the end of each 
focus to go back to 
the page you were 
reading.
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A.1 Perfecting Bass/Guitar 
authoring

The following is a summary of the official docs

Consistency
When possible, keep the same gems representing the same notes and with 
phrases that repeat throughout a song. Also, try to maintain consistency in chords 
throughout a song (e.g. if you use a Green/Yellow chord to represent a chord, it 
should represent that chord throughout the song) This is often impossible as many 
songs have more than 5 notes and 7 basic chords, but try to stick to it as much as you 
can.

Wrapping
Often times, a melodic line will contain too many notes to fit within our five button 
constraints. This can also become more of a problem at simpler difficulties when you 
must use fewer gems. When this occurs, we wrap the gems, using patterns such as 
Green/Red/Yellow, Red/Yellow/Blue Yellow/Blue/Orange.

Author intention over sloppiness
Much of rock and roll is sloppy by nature, however, our game is not. Therefore we 
need to “clean up” sloppy guitar parts. All authoring should be quantized (read our 
focus on Quantizing), usually to 16th notes (in some cases 32nd notes or triplets). 
The easiest way to do this is to use the Snap to Grid feature in Reaper when entering 
notes. If you can tell what the guitarist intended to play, but they just didn’t quite 
make it, author the part as intended. There is a gray area here when it comes to 
solos, as they can be intentionally sloppy.

If you want to know more, read the Bass/Guitar HMX docs.
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A.2 Authoring drums by ear

A.2.1 When you don’t have a MIDI for reference, the MIDI is unreliable or you 
don’t want to use a MIDI, start by Track > Insert new track, select the 
whole song, and Insert > New MIDI item. You have a new canvas to work 
on. Why not working directly on the PART DRUMS track? Two reasons: 
we want to leave those tracks pristine and devoted to the 5 lane charts 
alone and we want to author the single drum kit pieces for realism and 
consistency.

A.2.2 Now, play the song and do a first pass concentrating on lower and more 
promiment sounds: kicks, snare and toms. Why we do this in passes? It’s 
far easier to concentrate on specific sounds than the whole drums track. 
Choose which row to assign to which sound: use any row you like, just 
don’t use MIDI notes higher than 90 and always put the same sound on the 
same row. 

A.2.3 Start by adding kicks and snare markers. For simple songs, you probably 
can just add a pattern of snare and kicks for the whole phrase and just add 
or remove what’s needed when the pattern changes. When you get to a 
fill, always do kicks first (they can be very hard to recognise when there 
are also floor toms or even snare hits), then author the toms.

A.2.4 Once you have done a section on bass drum, snare and toms, go back and 
author cymbals.
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A.3 Perfecting drum kit 
sounds authoring

The following is a summary of the official docs

Colors and sound
It can be satisfying to author an expert drum level where each drum and cymbal 
matches perfectly to a pad on the Rock Band kit, but forcing this consistency doesn’t 
always make for a satisfying playable song. Let’s say there is a series of blue ride 
cymbal gems, with a fill on the 2nd rack tom. Even though up until then that rack 
tom was represented by a blue gem, you may want to consider that putting it on 
yellow emphasizes the fact that the gem is representing a drastically different sound 
than the blue gems surrounding it. After all, it’s a videogame - not a lesson in drum 
hardware!
However, things like hihats and ride cymbals have a more distinctive sound as well 
as a more important role within most beats, so their placement should remain 
consistent if possible. An exception to this guideline is when a tom fill requires that 
the author use all three yellow, blue and green gems for the toms. In this case, the 
last green tom gem will probably be followed immediately by a green crash gem. 
While an imperfect solution, it does prevent players from having to cross the right 
hand over the left to hit a cymbal on blue.
Standard Drum Rolls are authored on note 126 (F#8). They work similar to fills where 
you start the roll lane where the first note is authored, and you end the roll lane so it 
doesn’t overlap the last note in the roll.
Special Drum Rolls are authored on note 127 (G8). They are used for cymbal swells 
and allow the player to do a roll that is divided between two pads. It is authored the 
same way as normal rolls, but should only be used for special instances. 

“Disco” beats, or the “16 beat”
Some songs feature 16th notes on the hihats (think “Run to the Hills” by Iron 
Maiden). On a real drum kit, the drummer would play the hihat pattern by 
alternating both hands on the hats and hitting the snare with the right hand on beats 
2 and 4. This is difficult to do on the Rock Band kit, so we have a drum mix event that 
allows authors to put the hihats on red and the snare on yellow (read our focus on 
Events for disco beats). It’s worth listening to make sure that the drummer doesn’t 
actually hit the hihat simultaneously with the snare, because in some cases, the 
drummer is able to play all the 16th notes with the right hand without alternating. In 
this case you shouldn’t use the “disco flip” text event.

Hihats on Green
In the rare case that the left hand is playing at least 2 different toms or percussion 
while the right hand rides on the hats, it is ok to put the hihat gems on green, which 
frees up the left 3 pads to be played with the left hand. In a similar vein, the ride 
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cymbal can be authored on green if you need to free up the other pads for left hand 
action.

Snare Flams 
A “flam” is when a drummer strikes one drum with both hands, with one hand 
trailing slightly (usually the left), thereby giving the hit a fuller sound. We author 
snare flams as a simultaneous hit on red and yellow in order to show the player that 
both hands should be used. The yellow gem won’t have any mute/unmute effect on 
the snare stream - it’s authored that way to get both hands involved. This technique 
is also good for tom flams: even though both hands hit the same tom, we would 
author the hit on both yellow and blue (or blue and green) to force the player to use 
both hands.

Crash Cymbals
Crash cymbals can be authored on green, blue or yellow depending on the 
circumstance. For example, during a chorus the drummer is riding the crash cymbal, 
but hits another cymbal to accent the beginning of the next 4-bar chunk. In this 
case, we might have a series of green gems, with the accent crash falling on blue. 
Many drummers will hit 2 cymbals at once, to add extra emphasis. To replicate 
this emphasis on the Rock Band kit, we’d author the double crash hit on green and 
yellow.

Fudging tom pitches during fills
Be aware that if the drummer is doing rolls using multiple toms, you might run into a 
pattern that requires the right hand to cross over the left. It’s pretty difficult to cross 
hands going from green to blue, or even blue to yellow, so consider being nice and 
intentionally fudge the pitches of the toms so that it’s possible to play on the Rock 
Band kit. A good example of this would be when a drummer plays a long fill using a 
kit that has six toms. Obviously, our drum has only 3 toms, so if you want to capture 
the epic feeling of such a fill, you’ll need to “wrap” back around the kit, going from 
green back to yellow. In this case, it helps to set up the “wrap” by sending the left 
hand to yellow first, thus avoiding the need to cross hands. At faster tempos, this 
inaccurate transcription of tom pitches will be less noticeable. At slower tempos, 
however, the fudged pitches will be more noticeable and crossing hands will be 
easier, so feel free to author the section exactly as it was played.

Open Hihats on the upbeats
A common beat that we come across is played by striking the hihat on every 8th 
note - but closing the hats on the downbeat and opening them on the upbeat - giving 
the beat a syncopated feel. Authoring this beat as an alternating yellow and blue 
pattern - or even as a string of 8th notes all on yellow - may make the player feel 
disconnected from the audio. A better way to author this kind of beat is to place 
yellow or blue gems ONLY on the upbeats.

De-emphasized drum hits
Be aware that details that can be heard when listening to a soloed drum mix don’t 

2
HOW YOU 

DO IT

3
USING 

REAPER

4
IMPORTING 

ASSETS

5
AUTHORING 

BASS

6
AUTHORING 

DRUMS

7
AUTHORING 

KEYS

8
AUTHORING 

VOCALS

9
AUTHORING 

GUITAR

10
LOWER  

DIFFICULTIES

11
OD &  

DRUM FILLS

12
ANIMATIONS

13
BEATS & 
EVENTS

14
EXPORTING 
& MAGMA

a
FOCUS

b
HMX DOCS

TUTORIAL

1
Intro



34

CUSTOMS TUTORIAL FOR NEW AUTHORS

Focus

always translate well when playing with the rest of the band. A common example of 
this is when you can hear the drummer lightly tapping a crash, ride or hihat cymbal 
in between the more heavily emphasized downbeats. When playing such a drum 
part in-game, the extra 8th notes may be detracting from an intended quarter note 
groove. Similarly, you may hear a lot of accents and details in the soloed snare or 
kick stream that can’t be heard in the entire mix. Again, the author should listen 
to the groove as represented in the full mix so that the authored part doesn’t feel 
overcrowded with seemingly arbitrary gems.

Double Bass Pedals
In songs that feature double bass pedal work, there are a couple of different ways to 
approach the authoring – choosing just what the right foot is doing as the playable 
part, or finding an interesting and appropriate way to reduce a constant stream of 
kick drum hits into a pattern just the right foot can play. Be aware that a real kick 
pedal contains mechanisms that allow for a speedy, constant stream of bass drum 
hits, while too many kick drum gems in a row in Rock Band leads to fatigue, so let the 
tempo of the song inform your authoring. Note: As the Rock Band kit does allow for 
2 bass pedals to be used, you are allowed to release a version of your song, labeled 
“Song Name (2x Bass Pedal)”, which contains all the kicks, so long as there is a 
version playable with one foot.

Drum roll rules
- Don’t author a fill over a drum roll.
- Drum rolls should be saved for instances where the drummer is playing way too fast 
on one pad for our kit to pick up.
- Try to avoid stretching rolls out over multiple pads (ex. Quick descending tom rolls). 
It ends up looking poor in game. It’s best used on super fast and/or out of time rolls 
on individual toms, snare, or cymbals.

If you want to know more, read the Drums authoring HMX docs.
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A.4 Events for disco beats

A.4.1 If you’re doing multitrack customs, we really can’t make it any simpler 
than the official docs, so read the Official Drums authoring HMX docs. 
If however you’re using an MP3 or a WAV file of the final mix, you don’t 
need to worry about mixes and you can simply follow this short focus.

A.4.2 If you open the PART DRUMS MIDI track from your template you will notice 
a number of text events at the beginning of the track. Mix events are: [mix 
0 drums0], [mix 1 drums0], [mix 2 drums0], [mix 3 drums0]. All you need to 
know is that the number that changes represents the difficulty level. So, 0 
is for easy, 1 for medium, 2 for hard and 3 for expert. 

A.4.3 To author disco beats, select all yellow/hi hat notes on the disco beat 
sections and move them to an unoccupied note row (102 in example). 

A.4.4 Now select the snare hits in those sections and move them to the yellow 
notes row (row 98). Select all notes for row 102 (right click on the row 
names column) and move them to the snare row (row 97). 

A.4.5 Now you need to tell the game that for pro mode, in those section it needs 
to flip the notes and show the snare hits as hi hat and viceversa. To do 
so, create a new text event right before the first hit and name it [mix 3 
drums0d]. At the end of the section create a new text event and name it 
[mix 3 drums0] to reset the disco flip. 

A.4.6 If the disco beat is very easy to follow, you will probably want to keep it 
for the hard difficulty. In that case, add a [mix 2 drums0d] event and a [mix 
2 drums0] to reset the disco flip mode, same spots where you added the 
Expert difficulty events. For any difficulty level for which you don’t author 
two handed beats, just don’t add any text event and don’t swap hi hats 
and snare.
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A.5 Cleaning up a FoF 
guitar/bass chart

A.5.1 Frets on Fire charts are useful but most often than not a bit sloppy in terms 
of notes placement and length. First of all, select all notes, zoom in so that 
on screen you can basically see only a couple of measures, then from the 
Actions menu in the MIDI window select Shorten notes one pixel. Use it 3 
times. 

A.5.2 Now, with all the notes still selected, from the Actions menu in the MIDI 
window select Lengthen notes one pixel. Use it, again, 3 times. What that 
does is reduce all notes by 3 pixels first. What happens is that in some 
FoF charts, short notes have length 0, which is an issue in Magma. So, by 
reducing all notes, the notes with length 0 can’t be reduced anymore and 
will stay at 0. Once you lengthen all notes, all the long notes will go back 
to their original length, while the notes with length 0 will have length. It is 
crucial that you don’t change zoom level between actions. 

A.5.3 Once you have grown confident and you prefer to do a cleaner job, just 
select all notes, deselect all long notes and give all remaining notes a 1/32 
length, while checking that in very fast sections notes don’t overlap.

A.5.4 Now we need to take care of sustain length. In a lot of FoF charts sustain 
are too long, ending right before the following note. You need to shorten 
those so that you leave some space. There’s no exact science to do this 
automatically: select all notes, use the Shorten notes... action for how 
many times you need. Make it so that there’s more or less a 1/16 space 
between the sustain and the following note. 

A.5.5 Then, use the Lengthen notes... action 3 times to give all the short notes 
that are probably now at 0 length some length. This process is very quick 
but it will leave with a rough chart: once you are confident with your work, 
shorten notes by hand setting the Grid to 1/16 and dragging the long 
notes back accordingly. 

A.5.6 You now have a cleaner track. Once you are confident with your work, you 
can take care of two more things: note quantizing (read the focus) and 
sustained chords length (read the Common Magma errors focus).
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The C3 CON Tools 
MIDI cleaner can 
take automatically 
care of most of FoF 
issues.
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A.6 Reducing notes length

A.6.1 All notes that are shorter than ¼ don’t have a sustain. But all notes ¼ 
and longer must have a sustain that ends when the note sound ends but 
always at least a 1/16 before the following note. To help you with this 
just use the Grid drop down menu at the bottom of any MIDI window in 
Reaper. You can set it to ¼ to check for sustains and you can set it to 1/16 
to shorten notes. Shortening is simple: just drag the notes end tail back. If 
you set the grid to 1/16, just drag them back one “click”. 
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C3 PowerTip

There’s a CAT 
command for that! 
The Fix Sustains 
command will trim 
all sustains correctly 
according to HMX 
rules
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A.7 Quantizing

Notes for the game are, excluding complex tuplets, alwasy snapped to grid. That 
means a note at the very beginning of measure 3, beat 1 must be exactly at 3.1.00, 
not at 2.4.99 or 3.1.01. To do that, we quantize. Quantizing works this way: with a 
set Grid setting, notes are snapped to the nearest grid line. So, let’s say we have a 
measure with 16 consecutive hi hat notes: with a 1/16 grid setting, each note will be 
snapped to the nearest 1/16th grid line. As long as notes aren’t way off the grid (thus 
snapping to another grid line), any notes not exactly on the 1/16 grid will be snapped 
there. 

Proper grid settings
So, quantizing requires that you first select a Grid setting. This is absolutely key 
to proper quantizing. Incorrect quantizing will break the chart, so you need to be 
careful and know what you’re doing. In example, following the 1/16th scenario, if 
you 32 consecutive notes in a measure and you use a 1/16th grid, 2 notes will be 
snapped to each grid line, effectively shifting half of the notes 1/32 before or after 
where they should be and leaving only 16 notes (doubled, which will throw errors in 
Magma) in the measure. 
So, start off by understanding that you NEVER quantize an entire song without 
looking at how notes are laid out. Consider that some parts of a song may be in 
quarters (1/4th grid), others in 1/8th, others in 1/16th, others in 1/32th, etc. As a rule 
of thumb, you don’t need to quantize those parts with different actions, just select 
the highest notes density for grid setting, and snap: 1/4th notes near a 1/16th grid 
line will still snap correctly, in example (1/16th grid setting has 4 1/4th grid lines in 
it). 

Triplets
In addition to notes density, tuplets play a key role. Complex musical theory is 
outside the scope of this tutorial, so we’ll focus on triplets, which is probably the only 
kind of tuplets you will ever encounter for your songs. A song is divided in measures 
and measures in beat (see the BPM, Measures, beats and time signatures focus to 
know more if you have no idea how music works). Every beat is “filled” with an even 
number of notes. Triplets are group of 3 notes occupying a 2 notes space, so an odd 
number of notes for an even number of notes space. This means that the 3 notes 
(an odd number) won’t fit in the even number of grid lines (in ¼, 1/8, 1/16, 1/32, 
etc. grid). So, a triplet in a straight 1/16th grid will be snapped incorrectly, resulting 
in one note being snapped to the previous 1/16th grid line and on to the following, 
when in fact they are in the middle of the two grid lines. 
To snap triplets, quantize all the other straight notes, than select the triplet groups, 
switch grid setting to Triplets, and then quantize.
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Tuplets
You may also encounter tuplets that are difficult to snap (quintuplets, in example). 
In those cases, you can always just either leave them be if they’re not chords (it’s 
basically impossible to find a quintuplets or more complex chord) and see if in game 
they look evenly spaced. If not you can space them by hand leaving the same space 
between every note.

Swing tempo
Now, straight and triplet quantizing is taken care of. There’s one more kind of 
quantizing we need to care of, and that is the swing tempo. Sometimes song may 
not have a straight tempo feel (ta ta ta ta ta ta ta ta) or a triplets feel (tatata tatata 
tatata), but maybe have more of a swing feel (ta-ta ta-ta ta-ta). That means notes are 
not evenly spaced (which is true for a straight or triplet tempo) but are coupled: one 
note is close to the next than it is to the previous one. To account for that, use the 
Swing grid setting and use the slider to select the intensity of the swing, meaning 
how close together are the coupled notes. However, swing tempos are mainly true 
for the main beat of the song: fills, sweeps, any guitar/bass solo, etc. won’t, in 99% 
of the cases, have a swing feel. So, make sure you quantize using the swing grid only 
the notes that are actually coupled, and not all.

Reductions
Quantizing can also be very useful for reductions. Remember we talked about those 
1/32nd notes being snapped incorrectly and resulting in only 16 notes in a measure if 
you use a 1/16th grid? Well, that can be used to our advantage if we need to reduce 
charts. If a fast 1/16 sequence of notes on the hi hat needs to become a 1/8 sequence 
of notes to go from Expert to Hard difficulty, set your grid to 1/8, select all the 
relevant notes and quantize. 
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A.8 Count in 

Rock Band songs have a nice count in that helps player expect the tempo to be played 
and leads them at the beginning. Count ins require 2 measures of space, that’s why 
we always start our songs placing the audio at 3.1. Use any count in audio sample 
you think suits the song best. So, you will need 6 instances of the audio sample (just 
copy and paste it). Two samples will go at measure 1, beats 1 and 3. The other 4 will 
go at measure 2, one per beat (this is true for 4/4 songs but also for any song that 
does not have a very distinct swingy and “3” feel, all of which discussed in the Time 
signatures focus). That’s it, you now have a count in that goes something like “One 
and Two and One, Two, Three Four”.

C3 PowerTip

On the Web there 
are many free audio 
samples services. 
Find a drum sam-
ple that roughly 
matches your song’s 
sound or, if you 
have a song with 
portions with only 
drums in it, sample 
it directly from 
your song. That’s 
obviously very easy 
if you’re lucky enou-
gh to work with 
multitrack audio.
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A.9 BPM, Measures, beats 
and time signatures

This is not an exercise in music theory but a tutorial on customs, so we’re gonna 
focus on what you need to create a customs with a basic music knowledge. 

How a tempo map is set up
First of all, as you may already, the speed of a song is measured in BPM, or beats 
per minute. It’s, by the way, how the tempo map of a custom works: it’s a series 
of points, each with a BPM value. However, there’s far more to it. Any song is split 
in measures, each measure is split in a number of beats. There’s no set number of 
measures per song, but there’s a set number of beats per measure. How many? As 
a general rule, 4. Most pop, dance and rock songs work in 4/4 time signature. That 
means that every measure is composed of 4 ¼ notes. So, why do you need to know 
this? Well, to do a tempo map, you need to recognize the beats, because that’s how 
the tempo map works, in beats per minute. And actually, to need to recognize a 
measure, because that’s how you will do most tempo maps, by letting Reaper take 
care of setting the BPM value simply telling Reaper where a measure begins and 
where it ends. How to do that? Most pop/rock songs have a common structure: beat 
1 and beat 3 of a measure have a drum kick note; beat 2 and 4 have a snare note. 
Think of almost any AC/DC song. Identify those kick and snare notes to get a sense 
of the measure. They’re also important because since most drum fills end on the 1 
of the following measure with a kick note plus a cymbal hit, that’s where your OD 
activations should end. 

Different time signatures
Now, while this is true for probably 80/90% of rock/pop music, 4/4, though most 
popular, is not the only time signature. Recognising different time signatures like 
12/8 or ¾ is beyond the scope of this tutorial, however, two things are important. 
The first is to always check if a measure in Reaper has a drastically different tempo 
than the previous one even though the song doesn’t seem to have changed tempo 
that much. If this happens, you have probably encountered a time signature change. 
Say you started with a 4/4 time signature and at some point the song switches, 
maybe for just a measure, to ¾. Now, instead of hearing a kick, snare, kick, snare 
(< end measure), (begin measure >) kick, snare… you hear kick, snare, kick (< end 
measure), (begin measure >) kick, snare… You recognize the measure has ended 
because what follows is, again, a kick and a snare. You let Reaper calculate the BPM 
but at that point Reaper must fit 4 beats (you haven’t told the program to change 
time signature) into a 3 beats space (which is the space you have recognized as a 
measure), so the BPM rate will skyrocket. Again, you might now even recognize 
that a measure has ended when the time signature changes, but even if you don’t, 
remember that a sudden change in BPM with no apparent change in the tempo of 
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a song is a sign of a time signature change. Until you learn how to recognize time 
signature changes, just change BPM manually for those parts so that kick and snare 
hits look leveled with every beat of the measure. However, know that using wrong 
time signatures will result in a less “readable” fretboard, because hits supposed to be 
downbeat may show up as upbeat on the fretboard, in example.

Get help!
The other important thing to know is that there are ways to know the time signatures 
for a most non-obscure songs. You can use sheet music, MIDI files, Guitar Pro files 
and more to get correct time signatures. You can either set them manually in Reaper 
or import the MIDI file (Guitar Pro can export to MIDI) and have Reaper automatically 
add the time signatures to your tempo map. 

C3 PowerTip

Authoring from 
scratch using a MIDI 
is similar to impor-
ting a FoF custom, 
however you will 
have to do the tem-
po map yourself. So, 
import the MIDI as 
you would import 
a FoF MIDI (see 
Importing audio 
and MIDI). Then, 
without changing 
time signatures, 
tempo map your 
song following the 
Tempo mapping 
HMX docs. Before 
reading the official 
docs, take a look at 
the BPM, Mea-
sures, beats and 
time signatures 
focus if you want to 
know more about 
tempo mapping: re-
commended but not 
compulsory reading 
if you just started 
tempo mapping 
from scratch.
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A.10 Why do we need 
a muted track?

How does Harmonix cut off audio for single instruments if you miss a note and allows 
for things like guitar effects and drum fills? All official songs have multitrack audio, 
which is something we don’t have for customs, with very few exceptions. Magma 
though still wants an audio track for each instrument. Now, if you just link the full 
audio in Magma for each instrument, what happens is that when you miss a note, 
all the audio gets lowered, because the audio in the song is a sum of 4/5 copies of 
the same audio imported in Magma, one per instrument. So, when you miss a guitar 
note, the game lowers the guitar audio, thus lowering the audio for the whole song. 
Not only that: if you try to the whammy bar, things will get really messy, because 
the game will start distorting all instruments, not only the guitar track, which you 
don’t have. What you do then is having a muted track linked for every instrument in 
Magma and you only keep your full audio in the backing track.

C3 PowerTip

Magma v2 appa-
rently has a bug 
that distort audio, 
specifically the right 
channel, for songs 
with only 2 instru-
ments (in example 
drums and vocals). 
If you author a song 
with only 2 instru-
ments and notice a 
weird distortion in 
the right channel, 
add a mute track to 
the crowd channel 
in Magma.
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A.11 Perfecting MIDI 
translation for 

chords instruments

So, MIDI files are awesome because they help A LOT with authoring. However, MIDI 
files have limitations you need to overcome to perfect your songs.

Repetitions
Sometimes MIDI or GP files are translations of sheet music sources. Sheet music 
sources are not perfect duplicates of the original songs, most of all because they use 
Repetitions. In order to shorten the length of tablatures, segments of a song may be 
shown in the sheet music as repeated. In example, sheet music for a song that works 
with phrase, chorus, phrase, chorus, bridge, phrase, chorus may only have phrase, 
chorus and bridge transcribed. Granted, a lot of Guitar Pro files have a detailed 
transcription of all parts, but a lot others don’t. And that’s even more true for MIDI 
files. Now, very rarely those 3 phrases will be absolutely identical, which means 
that you will need to review the whole song to check that repetitions are correctly 
handled, otherwise you will need to adjust the chart accordingly during testing in 
Reaper. 

Bends
In game, bends are represented by 2 notes: the first is strummed, the second 
is a hammer on a 1/16th or 1/32nd later. In GP or MIDI files, bends are almost 
never represented by 2 or more notes. Instead, they are marked using Pitch MIDI 
commands. Those commands are useless for authoring, so you will need to check the 
song for bends. If you’re confident you can do that by ear, do so and then find the 
long notes with the bend, shorten it, shift it a 1/16th or a 1/32nd later, add a note 
before that and you’re done. If you’re not confident, don’t clean the MIDI file right 
away but in Reaper, MIDI windows, select Pitch from the MIDI commands drop down 
menu and go through those.
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A.12 Working with 
non-matching MIDI files

You can actually find files with different but working tempo maps. The reason is both 
time signatures and measures. There are two main scenarios for non-matching tempo 
maps: half/double tempo or different time signatures. 

Half/double tempo
A.12.1 This is the easiest scenario to deal with. You have a tempo map, in 

example, at roughly 70 BPM but the MIDI file you downloaded has a 
tempo map at roughly 140 BPM. That means that the MIDI tracks from 
the music MIDI file will look half as long as your game MIDI tracks. Or 
viceversa: your tempo map is faster than the music MIDI’s, so the music 
MIDI tracks will look double as long as your game tracks’. 

A.12.2 Open a the first instrument’s MIDI track and set the grid to ¼.
A.12.3 If the music MIDI is too short, draw a ¼ note at 1.1.00. Select all notes, 

press CTRL and keeping it pressed drag the right side of the note to the 
right until the note doubles in length. 

A.12.4 If it’s too long, draw a 1/2 note at 1.1.00. Select all notes, press CTRL and 
keeping it pressed drag the right side of the note to the left until the note 
halves in length and becomes a quarter note.

A.12.5 Repeat this for all instrument tracks. If you already know about quantizing 
(you can read the focus here), try to quantize all notes before doing these 
operations.

Different time signatures
In some cases, the tempo is going to be 30% slower or 30% faster, circa. The reason 
is that the time signature in the music MIDI is not a multiple of the game MIDI time 
signature (or viceversa). A more in depth explanation is outside of the scope of 
this tutorial, but an example, if you already know about time signatures, is that of  
12/8 and 4/4 time signatures in, respectively, the music MIDI and the game MIDI, 
or viceversa. In these cases, you could theoretically still use the trick used for half 
and double tempo, but it’s not gonna be that effective and the longer the song, the 
messier the MIDI tracks will look. For these files, there really isn’t a quick and dirty 
solution. You can use the same method you use for half/double tempo drawing a 
note and then instead of doubling/halving it you can shorten it or lengthen it by 30% 
or whatever percentage you need. However, notes won’t cleanly snap, so you will 
need to either do this in section of the song or be prepared to do a lot of cleaning up.

C3 PowerTip

In this examples, 
we are taking for 
granted that your 
game MIDI file has 
the correct tempo 
map. However, you 
may want to find 
the time to check 
whether it’s the 
music MIDI file that 
has the correct tem-
po map, in which 
case you need to 
apply the same 
steps to the game 
MIDI tracks and not 
to the music MIDI 
tracks.
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A.13 How to get a music 
MIDI

Finding a good source for your charts is essential. Even extremely competent authors 
use MIDI and Guitar Pro files. So, where do you get these files and which one do you 
need?

MIDI files

Pros and cons
MIDI files are perfect for all instruments, they tend to be available for a huge range 
of songs and they usually include all instruments. Always try to find one for your 
projects. Only con is that guitar may not be accurately sequenced.

Where to find them

Fan sites and aggregators
Google “<song name> MIDI” and you will probably get an insane amount 
of hits. You can find fan Web sites offering their MIDI version of a song or 
search engine devoted to MIDI files alone. If you find more than one MIDI file, 
download them all, because some may be more compete than others and in 
some cases you can get the full picture using 2 or free files.

MIDI shops
For a price ranging from 5 to 9 dollars you can find MIDI files for almost any 
non-obscure song. Is it worth it? Well, it depends on how good you are at 
authoring by ear. If you’re not, they are definitely worth it. Just make sure to 
download the demo version of a MIDI file before buying it so that you can make 
sure that all the parts you need are included, because in example sometimes 
MIDI files are karaoke versions, meaning they don’t have vocals but only 
backing vocals. Good MIDI shops with solid files are:
http://www.songgalaxy.com
http://www.backingtracksworld.com/
http://www.midi-hits.com

Guitar Pro files

Pros and cons
Guitar Pro files are digital tabs for guitar and bass, mainly. They are available mostly 
for guitar driven songs and they tend to have very accurate guitar parts. So, you’ll 

C3 PowerTip

When assessing the 
quality of a MIDI 
and the number of 
instruments sequen-
ced, don’t relyu too 
much on the MIDI 
voices assigned to 
each instrument. In 
example, vocals can 
often be assigned to 
clarinet, saxophone 
and more, so at a 
glance you wouldn’t 
think that the MIDI 
actually contains 
the vocal track.
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have limited selection for pop songs, but a huge range for rock and metal and you 
want to use these files for guitar parts. Also, they tend not to need much quantizing 
because they are always already quantized. Reaper does not import GP files, so 
download and install TuxGuitar (http://tuxguitar.herac.com.ar/), open any GP# (GP3, 
4, 5, 6, etc.) or PTB file, then File > Export > Midi.

Where to find them
There’s a number of guitar pro aggregators: just search what you want there and 
download. Some good aggregators with a huge archive are:
http://www.tabbest.com
http://www.tabscout.com

C3 PowerTip

If you need to au-
thor vocals, beware 
of paid “karaoke” 
MIDI. Those are 
generally very well 
done but don’t con-
tain the vocal track, 
while they usually 
have the backing 
track.
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A.14 Stepping down and up 

So, you’re playing back your MIDI chart and it all sounds so… off key? Sometimes 
songs are actually played half a step, a step or even more, up or down the original 
tablature. The concept is beyond the scope of this tutorial, what you need to know is 
that for vocals and pro keys you sometimes need to adjust your notes. If they sound a 
bit flat, select them all and shift them one row up. If they still sound flat, move them 
one row up again. On the other hand, if they seem a bit too sharp, move them down. 

C3 PowerTip

If only some notes 
sound off, make 
sure that once you 
have charted all 
bends as different 
notes you have 
cleaned the MIDI 
track and deleted 
all bend commands. 
Otherwise, the com-
mands that lowers 
the note’s pitch, in 
example, will lower 
the already lowered 
note’s pitch thus 
making it sound off.
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A.15 Advanced Venue Editing 

The biggest thing is here to get the guitarist and bassist to sing the HARM2 and 
HARM3 parts. To game will generate the lipsync for the guitar and bass players 
based on the dryvox files you provide it in Magma. Even after the game knows HOW 
to animate the lips, it needs to know WHEN. You do this by drawing on the VENUE 
track on the “Guitarist Sing Along” or “Bassist Sing Along”. Select both the HARM2 
and VENUE tracks (ctrl + click) and then opening them both in the editor (Ctrl + Alt 
+ E). Have the HARM2 in the background, and just draw the notes on the VENUE 
track. Then repeat with HARM3. If you want the drummer to sing along, draw in the 
“Drummer Sing Along” line. This will enable the drummer’s lipsync, which follows 
the lipsync of HARM1. Next you might want to change some camera shots, so let’s go 
over some basics. Camera shots are specified in the VENUE track as text events. 
Normal camera cuts start with [coop_ and are followed by the instrument(s) that 
you want to have in the shot. [coop_g_near], as the name implies, will show you the 
guitarist. [coop_b_near] will show you the bassist, [coop_bg_near] will show you 
both. You can do [coop_all_near] to do a sort of close shot of all the players, and you 
can do [coop_all_far] to show the whole venue, players and some of the crowd.
If you want to highlight an instrument, you can do a closeup shot. [coop_g_closeup_
hand] will put the camera on the guitarist’s hand. Similarly for [coop_b_closeup_
hand], [coop_d_closeup_hand], etc. If you’d like to show the player’s faces, replace 
_hand] with _head]. Note that the vocalist closeup is just [coop_v_closeup] and it 
is only the face. The fun parts are directed camera cuts. These are the “solo” style 
animations, where the players point at the camera, kick, or something else that’s 
special. Those camera cuts start with [directed_ and there’s a variety of them. Refer 
to RBN Docs for their usage. Original Magma limited you to 19 of these, Magma: C3 
Roks Edition raised this limit to 50.

Now that you have an idea of how to do the camera changes, you need to go 
back and check the lipsync animations. Are there parts where the lead singer isn’t 
singing but instead only the harm2/harm3 parts (i.e. the guitar or bass player?) If 
so, I recommend changing all [coop_v_near] to [coop_g_near] or [coop_b_near] 
depending on which part is singing, and any [coop_v_closeup] with [coop_g_
closeup_head] or [coop_b_closeup_head]. This will ensure that you don’t have the 
camera on the vocalist while you hear singing done by the guitarist or bassist.
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C3 PowerTip

RB3 uses camera 
shot “pools”, where 
you have more than 
one kind of shot for 
every camera call. 
So calling [coop_g_
near] will give you 
one of those pool 
shots, and won’t 
always be exactly 
the same.
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Harmonix Docs

Now that you have all the information needed to author, we will 
point you to the official Harmonix Docs. They’re not incorporated 
anymore in this PDF because they’re constantly updated but they 
are recommended reading once you are ready to polish your 
songs so that they are of a level similar to that of official releases. 
Please refer to the address in the box to the right.

C3 PowerTip

If you want the ori-
ginal version of the 
documentation, visit 
the official Web site  
at http://pksage.
com/rbndocs/.
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